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The 3 C's seminar 
(or Cleaning your Computer of Crud) 

 
Why should you clean your system? 
Do you remember how fast your computer was when you first got it? This is because you 
hadn't yet installed all those programs and utilities that you no longer use. Most of these 
programs leave behind temporary files and registry entries, even when uninstalled!  Just like 
your car, your computer needs regular maintenance.  
Plus your operating system records every visit to every website; every time you open a 
document, and a lot more. Do you want people to be able to find out this information?  
Even if you don't mind other people knowing what websites you visit, your internet browser 
can save personal information about you, such as your name, address, date of birth, 
passwords and credit cards numbers.  
In today's seminar, we will cover the basic techniques that will clean out the unnecessary files 
that accumulate in a Windows-based computer.  Not only will your computer disk recover 
valuable space, but its speed and performance will be improved. 
Those items that have an asterisk ( ) by their side are items that are recommended to be 
performed at least monthly, or weekly if you are an intensive user of your computer.  The 
other items need only be performed every three to six months. 
They are in the order in which I will go through them.  The following pages contain more 
detailed instructions on how to perform each of these items to help complete these tasks on 
your own computer when you get home.  I recommend that you follow these notes as I 
demonstrate each point. 
 

1. Create a Restore point. 
2. Remove Unused/Un-needed programs 
3. Perform a Disk Check (Windows utility) 
4. Remove temporary files using Disk Cleanup (Windows utility) 
5. Cleaning cookies 
6. Remove temporary files, cookies and MRU’s using CCleaner (freeware) 
7. Clean registry using CCleaner 
8. Check for Spyware using Ad-Aware and SpyBot (freeware) 
9. Remove unneeded Autostart programs 
10. Defragment hard drives 
11. Backup your Data Files using SyncBack (freeware) 

 
Step 1 is just a precaution before performing the other steps.  I guarantee that if you perform 
steps 2-10, your computer will run significantly faster. 
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1.  Create a Restore Point 
1. Access the System Restore Wizard through System Tools. (To access the System 

Restore Wizard, click Start, and then click All Programs, then Accessories, 
System Tools & System Restore.) 

2. Click System Restore 

 
3. Click Create a restore point, and then click Next.  
4. In the Restore point description box, type a name to identify this restore point. System 

Restore automatically adds to this name the date and time that this Restore Point is 
created.  

a. To finish creating this restore point, click Create.  
b. To cancel restore point creation and return to the Welcome to System Restore 

screen, click Back.  
c. To cancel restore point creation and exit the System Restore Wizard, click 

Cancel.  

Note: We will use 
this same folder 
(System Tools) to 
access the Disk 
Cleanup & disk 
Defragmenter tools
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2. Remove Unused and Un-needed programs. 
Clear Out Forgotten Programs 
The first step in tuning up your computer's performance is to remove any unnecessary 
programs. I install new programs all the time. Sometimes I'm thrilled with the new program 
and I continue to use it. Other times, it doesn't do what I hoped, and the program sits on my 
computer consuming resources. 
Follow these steps to remove unneeded programs: 

1. Click Start, and then click 
Control Panel 

2. Click Add or Remove 
Programs 

3. Scroll through the list and 
examine each program. 
Windows XP lists how often 
you use a program and what 
day you last used it. As shown 
in Figure, Atomic Mail Sender 
is a good candidate for 
removal from my computer. 
You shouldn't remove 
anything labeled as an 
Update or Hotfix, however, because they improve the security of your computer 

4. Click each program you no longer need, click the Remove button, and then follow the 
prompts to uninstall it 

You may have to restart your computer after removing a program. After your computer 
restarts, repeat the steps above to remove more programs.  

3.  Perform a Disk Error Check 
You can use the Error-checking tool to check for file system errors and bad sectors on your 
hard disk. 

1. Open My Computer, and then select the local disk you want to check.  
2. On the File menu, click Properties.  
3. On the Tools tab, under Error-checking, click Check Now.  
4. Under Check disk options, select the Scan for and attempt recovery of bad 

sectors and Automatically fix …errors check boxes.  
To open My Computer, click Start, and then click My Computer.  
All files & programs must be closed for this process to run. If the disk is currently in use, a 
message box will appear prompting you to indicate whether or not you want to reschedule the 
disk checking for the next time you restart your system. Then, the next time you restart your 
system, disk checking will run. Your disk will not be available to perform other tasks while this 
process is running. 
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Repeat for other hard disks drives – if your computer has them. 
Note:  Disk checking can take up to an hour – so make sure you don’t need to use the 
computer when you run this check! 

4. Remove Temporary Files Using Disk Clean Up Utility 
Many applications use temporary files when working to save information. These are normally 
deleted upon exit, but occasionally they can be left behind.  Sometimes Windows uses files 
for a specific purpose and then retains them in a folder designated for temporary files. These 
files are located in a specific folder, and can safely be removed. 
Temporary Internet files are mainly web pages and pictures saved from the sites you're 
visiting to your hard disk. These can build up over time to consume a large amount of disk 
space and may potentially contain personal information.  
Use the Windows Disk Cleanup Wizard (note, that if you want to use CCleaner, a freeware 
program described in Step 6, you can skip this step) to perform all of the following tasks to 
safely delete temporary files and create space on your hard disk: 

• Remove temporary Internet files.  

• Remove any downloaded program files (ActiveX controls and Java applets 
downloaded from the Internet).  
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• Empty the Recycle Bin.  

• Remove Windows temporary files.   

Using Disk Cleanup 
Disk Cleanup helps free up space on your hard 
drive Disk Cleanup searches your drive, and 
then shows you temporary files, Internet cache 
files, and unnecessary program files that you 
can safely delete. You can direct Disk Cleanup 
to delete some or all of those files. 
To open Disk Cleanup, click Start, point to All 
Programs, point to Accessories, point to 
System Tools, and then click Disk Cleanup. 
I recommend checking ALL boxes, except 
Compress old files and Office Setup Files (if 
shown). 
If you have more than one hard drive, repeat 
for the other drives. 

About cookies 
Some Web sites store information in a small 
text file on your computer. This file is called a 
cookie. It stores information on your computer, 
such as your preferences when visiting that site. For example, when you revisit a site like 
Amazon.com, recommendations based on previous purchases may appear.  Or you might 
want a personalized page at Yahoo.  
Cookies can also store personally identifiable information. Personally identifiable information 
is information that can be used to identify or contact you, such as your name, e-mail address, 
home or work address, or telephone number. However, a Web site only has access to the 
information that you provide.  A Web site cannot determine your e-mail name unless you 
provide it. Also, a Web site cannot gain access to other information on your computer. 
Internet Explorer allows the use of cookies; however, you can change your privacy settings to 
specify that Internet Explorer prompt you before placing a cookie on your computer, which 
enables you to allow or block the cookie. You can also prevent Internet Explorer from 
accepting cookies from the privacy settings which allow you to specify how you want Internet 
Explorer to handle cookies from individual Web sites or all Web sites.  However, some 
websites might not work properly (on-line purchasing), if you block all cookies. 
You can find out more about Privacy settings and security zones, by clicking Help on the 
Internet Explorer tool bar and clicking Contents and Index. Click the Search tab. In the 
“Type in keyword to find” box, type Privacy Settings or Security Zones. Click the List 
Topics button. Select a topic in the left window pane. Click the Display button and read 
about the topic in the right window pane. 
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5.  Remove unneeded cookies using IE Explorer. 
Note: If you plan to use CCleaner, a freeware program described in Step 6, you can skip 
Step 5. 
Some Web sites such as Hotmail or Yahoo! Email store your member name and password or 
other personally identifiable information about you in a cookie; therefore, if you delete that 
cookie, you may need to re-enter this information the next time you visit the site.  

1. To delete a particular cookie, click Start 
and then click Control Panel. 

2.  Click Network and Internet 
Connections, (you will only see this if in 
category view) 

3. Click Internet Options to open the 
Internet Properties window.  
Note: You can also get to the Internet 
Properties window by starting Internet 
Explorer, clicking Tools on the menu bar 
and then clicking Internet Options. 

4. On the General tab, click Settings  
5. Click the View files button  

A window opens displaying all the cookie 
files.  

6. Click on a cookie you want to delete and 
press the Delete key on the keyboard . 
 

(Hint - Use the Ctrl Key to select multiple cookies, before pressing the delete key) 
 
 
 
 
 
 
 
 
 
 
 
 



Gold Country Computer Learning Center The 3 C’s Seminar 

Roger Thornburn 01/06 Page 7 of 16 01/06 

To Delete all cookies 
On the General tab of the Internet Properties window, click the Delete Cookies button. 

6.  Remove temporary files, cookies & MRU’s using CCleaner (freeware) 
What is CCleaner?  It’s an 
excellent freeware tool that 
removes unnecessary files 
and cleans the registry. (see 
p.13 for download site) 
Open CCleaner and you will 
see the main cleaner page.  
All the items that can be 
removed are shown in various 
groups, together with a check 
mark to indicate if you want 
that item cleaned.  There are 
two tabs, “Windows” and 
“Applications”. In the Windows 
tab, I normally check all items 
as shown.  Similarly for the 
Application tab.  There is a 
description of each of these 
file types, on the last page.  
The next step is to set up the 
options – particularly for 
cookies.  This is a great 
feature of this utility – that you can select cookies you do not want to remove.  Click Options 
and Cookies and then use the arrow buttons to move the cookies between the two columns. 
Having made the selections, return to Cleaner and click the analyze button.  This runs a 
simulation, allowing a check of all the files that will be deleted.  If all is ok, click the “Run 
Cleaner” button to remove much of  the 
junk from your computer. 
From now on, all that’s needed on a 
weekly basis, is to open CCleaner, click 
the “Run Cleaner” button and the junk will 
be removed as per the options selected. 
Using CCleaner, is an alternative to 
Steps 4 and 5 previously described. 

7.  Cleaning the registry. 
The registry is a large file where 
programs keep information they need 
about where you keep your documents, 
or where a program keeps it’s data file.  
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Often, when programs are removed from your computer, they don’t “clean up” all their entries 
from the registry.  CCleaner has a very safe registry cleanup function. 
Open CCleaner and click the issues button.  Leave all the check marks checked, and click 
“Scan for Issues”.  When complete, click “Fix Selected Items”.  I recommend you click “Yes” 
to make a backup of the deleted items.  Then click “Fix all Selected Issues” and OK and then 
Close. 

8.  Check for Spyware 
Spyware is either a program or cookie that is put on your computer from a Website you’ve 
visited or loaded with another application.  Spyware can range from non-harmful (tracking 
your preferences for targeted marketing) to malicious (key loggers and redirectors).  To 
detect and remove spyware, you need additional programs.  There are quite a lot of freeware 
spyware removal programs. One that’s very popular can be downloaded free from 
www.lavasoftusa.com then click on Ad-Aware Personal and follow the links to download a 
free personal copy.  Another highly recommended spyware program is SpyBot.  This can be 
obtained from www.safer-networking.org/en/download/  and click on Download Here.   

Ad-Aware 
Start Ad-Aware and click OK to check for updates (must be connected to the internet for this 
to work).  Then click “connect” and after download is complete, click “Finish”.  In main 
window, click “Start” to start the scan.  When the scan is complete, you will see a list of all the 
items found.  I recommend you click the check marks to delete everything that Ad-Aware 
finds.  Then click quarantine.  
This allows you to “undo” the 
removal if needed.  

SpyBot 
Start SpyBot.  As always, click 
the “Search for Updates”, put a 
check mark in all those available, 
and click “Download Updates”. 
After the downloads are 
complete, click the “Check for 
problems” button.  When scan is 
complete, click “Select all” and 
then “Fix selected problems”. 
Finally, click the “Immunize” icon. 
At the screen that appears, click 
the “+ Immunize” icon to block over 
8,000 websites from being accessed.  
The Immunize icon needs to be re 
clicked, every time an update includes 
“updates to the immunization 
database”. 
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9.  Remove Autostart Programs 
This next step in restoring your computer's performance can often be the most significant.  
We need to identify any unnecessary programs that start automatically. Often, programs 
configure themselves to run in the background so that they appear to start quickly when 
needed. Some of these programs show an icon on your taskbar to let you know that they're 
running, while others are completely hidden. These autostart programs can often slow down 
your computer as it starts up, and will steal away memory and processing time as your 
computer runs. 
Some autostart entries are 
important programs (e.g. an Anti 
Virus program) or drivers required 
for some of the computers 
hardware.  So you should not 
simply delete everything that you 
don't recognize.  
Windows XP comes with the 
System Configuration tool 
(msconfig.exe), an excellent way to 
manage the startup process. To 
open this utility: 

1. Click Start, click Run, type 
msconfig, and then press 
Enter 

2. On the Startup tab, you'll see a list of all the programs and processes that are set to 
run when Windows XP loads. 

3. Speed up your overall start time by clearing the check box next to unneeded startup 
programs. (see below) 

4. Click Apply, and then restart your computer for the changes to take effect.  
NOTE: When an item is unchecked, it is NOT deleted, but just disabled from loading.  If you 
find later that this file is required at start up, then it can be enabled by rechecking that file.  
Checking for Startup Items.  You should look up each entry at www.sysinfo.org  At this 
website, click “Full Startup List” and then type in the “Startup Item” to the search box and click 
the Search button.  When an entry is found, check that both it’s Startup Item name and the 
last name in the Command are the same as on your computer.  By the side of the entry will 
be a description of the startup item and a code as to whether this is required to start 
automatically. Another site that provides similar info is www.answersthatwork.com   Click on 
Task List and then click the letter of the first letter of the file you’re trying to identify 
For example, the figure shows “msconfig” revealing a file called ccApp.exe that is set to start 
automatically. I visited The Startup Applications List, typed in ccApp and discovered that 
“App.exe is Part of Norton AntiVirus 2003. Auto-protect and E-mail will not function without 
this.”  This is obviously a necessary file, so it will stay!.   

Command

Startup Item
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Again, when checking an entry in 
the Sysinfo.org database, it’s very 
important to check that both the 
“Start Up” and “Command” are the 
same as in the configuration utility. 
Important.  After rebooting the 
computer, a window will appear 
notifying you that the System 
configuration Utility has been used.  

Make sure you place a check mark as shown, and then click OK. 

10.  Defragment Hard Drives 
I hate newspaper articles that start on the front page but continue somewhere in the middle of 
the newspaper. I could get through the article much faster if it was printed on consecutive 
pages like a magazine article. Files on your computer can either be fragmented like a 
newspaper, or unfragmented like a magazine. Over time, more and more files become 
fragmented. When a file is fragmented, it takes longer for the computer to read it because it 
has to skip to different sections of the hard disk—just like it takes me a few seconds to find a 
page in the middle of a newspaper. The figure compares how a computer reads 
unfragmented and fragmented files. 
You cannot work on your computer and defrag your computer at the same time. It is common 

for disk defragmenter to take a long time. 
The time can vary from 10 minutes to 
many hours, so run the Disk 
Defragmenter when you don’t need to 
use the computer!  If you defragment 
regularly, the time taken to complete will 
be quite short. 
To run the Disk Defrag utility do the 
following. 
 

Make sure ALL programs are closed  
If necessary, turn off your screensaver.  
Click on Start on the task bar. 
Point to All Programs. 
Point to Accessories. Point to System Tools. 
Click Disk Defragmenter. The Disk Defragmenter window appears. 
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Note: You can also get to this 
screen as follows. Double-click 
My Computer. Right-click the 
drive (volume) you want to 
analyze or defragment. Click 
Properties. Click the Tools tab. 
Click the Defragment Now 
button.  
Click the Defragment button. 
 
The Disk Defragmenter window 
consists of two main areas. The 
upper portion lists the disk 
(volume) on your computer. The 
lower portion displays graphical 
representations of the amount 

of fragmentation on the disk before and after running defrag.  The colors of the display 
indicate an approximation of the volume's condition: 
Red areas represent 
fragmented files.  
Blue areas represent 
contiguous (non-
fragmented) files.  
White areas represent 
free space on the 
volume.  
Green areas 
represent unmovable 
files, which cannot be 
relocated by Disk 
Defragmenter.  
Note: On file 
allocation table 
(FAT)/FAT32 
volumes, the green 
areas typically 
represent paging files, 
which are also called swap files. 
When the defragmentation process is complete, the computer will display a window with a 
close button that you should click. 
If you have more than one hard drive, repeat the process for the other drives 
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11. Backup your Data! 
It’s very, very important to regularly back up your data.  Every hard drive made, will one day 
fail, and all your data will be lost. 
Fortunately it’s very easy to do.  I recommend backing up to a second hard drive (internal or 
external), a USB flash/pen drive or CD/DVD.  Depends on how much data you have.  To 
cover the subject properly – requires another seminar.  This is just a straightforward example 
of backing up files to a USB pen drive.  For many people, this will be the best way. 
After downloading and installing 
SyncBack (freeware), open the 
program. The first time the 
program is started, it asks to 
create a new “Profile” (a 
backup job).  Select “Backup” – 
(synchronizing is generally 
used to get the files the same 
on 2 computers) and give it a 
name.  Leave the default 
setting (backing up source 
directory, including all sub-
directories) and select the 
source and destination 
directories.  The source is the 
folder you want to backup, and 
for most people this would be 
“My Documents”.  The 
destination folder is the drive of 
the backup media – in this case 
the USB drive (E:\) 
For most people this is all that needs to be done, although there are many options for the 
more experienced user.   
Now click “OK” to save this profile.  If you want to make simulated run, click “yes”, otherwise 
click “no”.  Back 
at the main 
screen more 
profiles can be 
created – if you 
wanted to backup 
different folders 
and/or to different 
media.  Select 
the profile you 
want to run and 
click “Run” 

Click folder to 
select source

Click folder 
to select 

destination

Default selection is 
good 
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The first backup can take a while to complete, but subsequent backups go much faster as 
only new files or files that have been changed need to be copied to the backup drive. 
SyncBack can also run any profile on a scheduled basis – which is great if your computer is 
normally switched on at the same time each day/week. 
So that’s it.  You should now have a clean, high performance computer back on, or under 
your desk.  All your valuable data should be safely backed up so that you’ll be able to keep 
smiling, when one day the disk decides to leave this mortal planet! 
Just remember, running disk check, disk cleanup, checking for spyware, keeping your 
cookies clean and defragmenting your hard drives regularly, will keep your computer running 
at peak performance.  I guarantee it! 
 

Useful freeware sites: 
CCleaner: www.ccleaner.com 
Adaware: www.lavasoft.com and click “AdAware Personal” in the products section 
Spybot: www.safer-networking.org/en/download/  and click the first “Download here” button 
SyncBack: www.2brightsparks.com/downloads.html and click the English flag to download 
 
Check information about “Start Up” programs: www.sysinfo.org and 
www.answersthatwork.com/Tasklist_pages/tasklist.htm  
A source for many good Spyware, Antivirus and Firewall products: 
www.thefreecountry.com/security/ 

List of files types cleaned by CCleaner 
Windows Tab  
Internet Explorer 
Temporary Internet Files  
This is the Internet Cache for IE. It saves the web pages and pictures from the sites you're 
visiting to your hard disk. These can build up over time to consume a large amount of disk 
space and may potentially contain personal information. Selecting this option will safely 
remove the files.  
Cookies  
Cookies are small text files that Web sites save on your computer to help your browsers 
remember specific information. For example, they might store your username and password. 
They are also used to store your preferences for personalized pages or to build a profile of 
which sites you visit and which banner ads you click on. Advertisers use this information to 
deliver targeted ads directly to your computer. Selecting this option will safely remove the 
files. You may wish to keep certain cookies, these may be selected on the Options window.  
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History  
Much like the Internet Cache, IE also records and stores the addresses of all the websites 
you have visited. Selecting this option will safely remove the record of websites you have 
visited.  
Recently Typed URLs  
Any website addresses you manually type into the address bar are stored and displayed in 
the address drop-down box. Selecting this option will safely remove the record of typed in 
addresses.  
Delete Index.dat files  
Although essentially undocumented by Microsoft there are several hidden files, all with the 
filename index.dat that reside in directories on your system. These permanently cache 
website addresses and cookies from sites you have visited. This list is never deleted and 
gradually increases in size, resulting in IE slowing down. Selecting this option will mark these 
files for deletion the next time your computer is rebooted. (Unfortuately these files cannot be 
deleted immediately as they are permanently in use by the operating system.)  
Last Download Location  
When you download a file from the internet, IE remembers the directory location you chose. 
Selecting this option will clear the last directory, and reset to the default folder. Which on 
most systems is the desktop.  
Autocomplete Form History  
When you type in a username and password on a webpage, IE frequently prompts you to 
select whether you'd like it to remember these details for next time. Whilst this is very useful 
and may save you time logging in. It can be a security risk as other people will be able to log 
in from your computer. Selecting this option with remove any stored usernames and 
passwords.  

Windows Explorer 
Recent Documents  
When you open a document or file in Windows, a record of this is stored under the Recent 
Documents list on the Start menu. Selecting this option will clear this list. (Note: The 
documents themselves are left untouched.)  
Run (in Start Menu)  
An alternative to running programs from a shortcut icon, is to type in the application name 
into the Run form on the start menu. Every time you do this, the program you typed in is 
added to the drop-down list of previously run programs. Selecting this option will clear this 
list.  
Search Assistant Autocomplete  
When you search for a file in Windows Explorer, the file is added to a list of previously 
searched for files. Selecting this option will clear this list.  
Other Explorer MRUs  
MRUs (Most Recently Used) are lists within windows and in applications that maintain a list of 
the last few (normally 4 to 8) opened documents. It is normally located on the File menu of 
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the application. This option clears a range of minor lists within Windows, including common 
dialogs, network drives and DirectX applications.  

System 
Empty Recycle Bin  
This option will empty the Recycle Bin.  
Temporary Files  
Many applications use temporary files when working to save information. These are normally 
deleted upon exit, but occasionally they can be left behind. Normally when the program is not 
shut down properly. This option will safely delete these files. (By default it only removes files 
that haven't been used in the last 10 days, this prevents current temp files from being 
removed. There is an option to turn off this feature on the Options window.)  
Clipboard  
The windows clipboard can contain personal information you've copied from documents and 
also if it contains a large amount of data, it can use up a lot of memory. This option clears the 
clipboard and frees up the memory being used.  
Memory Dumps  
When windows crashes or blue screens the system saves a memory dump, potentially 
containing information about how the crash happened. This data is generally never needed, 
even by advanced computer professionals and may be safely deleted. This option will 
remove these memory dumps.  
Chkdsk File Fragments  
Chkdsk (CheckDisk) is the utility windows uses to scan the hard disk for files errors. 
Sometimes it finds fragments of files left on your system. These are saved as .CHK files on 
your system drive. In most cases these files are never needed and may be safely deleted. 
Selecting this option will remove these files.  
Windows Log Files  
When you install a new program or piece of hardware Windows logs the changes to .LOG 
files in the Windows directory. In most cases these files will never be needed, even for 
advanced users. This option will safely delete these files.  
Old Prefetch Data  
In Windows XP a Prefetch file is generated each time an application is run. This helps 
Windows optimise the application the next time it is executed. Unfortunately these files are 
not deleted when the applications are removed. This option removes these files for programs 
that haven't been accessed in 14 days. (This process is very safe and Windows will recreate 
the files as necessary.)  
IIS Log Files  
IIS (Internet Information Server) is the service Windows uses to display web pages. This 
comes with most XP Pro and Windows 2000 installations and is generally only used by web 
developers or designers. Every time someone requests a page it gets logged to a text file. 
Unless the computer is a web server, these are generally not needed, and may be safely 
deleted. This option will safely delete these files.  
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Advanced 
Menu Order Cache  
The Start menu allows you to set a custom order to the programs listed, although there's no 
option to sort all folders by name. Selecting this option removes any custom ordering from the 
Start menu.  
Tray Notifications Cache  
In Windows XP the System Tray (the set of icons next to the clock in the bottom-right corner) 
orders and hides items automatically for you. Whilst this is useful, it records a list of every 
program that has been run from the tray. This option clears the list of previous programs and 
removes any custom display/hide options. (Warning: This won't have any affect until you 
manually restart the explorer process from the Task Manager.)  
Window Size/Location Cache  
Windows Explorer stores the view formatting and ordering settings for each folder on your 
system. After some time, this can contain a large amount of redundant data and may even 
slow down browsing for files on your system. Selecting this option will clear this data and 
reset the Windows Explorer display settings to their default option.  
User Assist History  
The start menu on Windows XP displays a list of the most recently run programs. Selecting 
this option will clear this list. 


